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Abstract: In order to gauge how reasonable a fi-
nite element solution to a partial differential equa-
tion is on a given mesh, a common strategy is to
refine the mesh, compute the solution on the finer
mesh, and use the solutions on the two meshes for
a qualitative comparison. The theory of the fi-
nite element method (FEM) makes these compar-
isons quantitative by estimating the convergence
order of the FEM error on a sequence of progres-
sively finer meshes. We will show how to carry out
convergence studies of this type in the graphical
user interface of COMSOL 4.0 on the example of
Lagrange elements of varying polynomial degrees,
which will also bring out the benefit of using higher
order elements.
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1 Introduction

The finite element method (FEM) is widely used
as a numerical method for the solution of PDE
problems, especially for elliptic PDEs such as the
Poisson equation with Dirichlet boundary condi-
tions

−∆u = f in Ω, (1.1)
u = r on ∂Ω, (1.2)

where f(x, y) and r(x, y) denote given functions
on the domain Ω and on its boundary ∂Ω, respec-
tively. Here, the domain Ω ⊂ R2 is assumed to be a
bounded, open, simply connected, and convex set
in 2 dimensions with piecewise smooth boundary
∂Ω.

The FEM solution uh will typically incur an er-
ror against the PDE solution u of (1.1)–(1.2). This

error can be quantified by bounding the norm of
the error u − uh in terms of the mesh spacing h
of the finite element mesh. Such estimates have
the form ‖u− uh‖ ≤ C hq, where C is a problem-
dependent constant independent of h and the con-
stant q indicates the order of convergence of the
FEM, as the mesh spacing h decreases. We see
from this form of the error estimate that we need
q > 0 for convergence as h → 0. More realisti-
cally, we wish to have for instance q = 1 for linear
convergence, q = 2 for quadratic convergence, or
higher values for even faster convergence.

One appropriate norm for FEM errors is the
L2(Ω)-norm associated with the space L2(Ω) of
square-integrable functions, that is, the space of
all functions v(x) whose square v2(x) can be inte-
grated over all x ∈ Ω without the integral becom-
ing infinite. The norm is defined concretely as the
square root of that integral, namely

‖v‖
L2(Ω)

:=
(∫

v2(x) dx
)1/2

. (1.3)

Using the L2-norm to measure the error of the
FEM allows the computation of norms of errors
also in cases where the solution and its error do
not have derivatives. Lagrange finite elements
of degree p, such as available in COMSOL with
p = 1, . . . , 5, approximate the PDE solution at sev-
eral points in each element of the mesh such that
the restriction of the FEM solution uh to each ele-
ment is a polynomial of degree up to p in each spa-
tial variable and uh is continuous across all bound-
aries between neighboring mesh elements through-
out Ω. For the case of linear (degree p = 1) La-
grange elements, we have the well known a priori
bound (e.g., [1, Section II.7])

‖u− uh‖L2(Ω)
≤ C h2
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provided u ∈ H2(Ω). The assumption on u is en-
sured if the right-hand side of the PDE (1.1) satis-
fies f ∈ L2(Ω). We notice that the convergence or-
der is one higher than the polynomial degree used
by the Lagrange elements. Analogously, a more
general result for using Lagrange elements with de-
grees p ≥ 1 is that we can expect an error bound
of [5, Section 6.2.1]

‖u− uh‖L2(Ω)
≤ C hp+1. (1.4)

The first purpose of this note is to demonstrate nu-
merically that for an appropriate example this be-
havior can be observed for the Lagrange elements
with all possible orders p = 1, . . . , 5 available in
COMSOL; this is the contents of Section 3.3. The
second purpose is to explain in detail how to con-
duct these convergence studies in COMSOL 4.0.
An update of this note for COMSOL 4.0a and ex-
tension to using LiveLink for MATLAB is the topic
of [6].

2 Elliptic Test Problem

In this section, we consider the classical elliptic
test problem on a polygonal domain, which can be
partitioned into the finite element mesh without
error. Specifically, we choose the square domain
Ω = (0, 1)× (0, 1) ⊂ R2 and supply the right-hand
side of (1.1) as

f(x, y) = −2π2 cos (2πx) sin2 (πy)

−2π2 sin2 (πx) cos (2πy),
(2.1)

and the homogeneous Dirichlet boundary condi-
tion of (1.2) as

r(x, y) = 0. (2.2)

This problem has been chosen as it has the known
PDE solution [4]

u(x, y) = sin2 (πx) sin2 (πy). (2.3)

The test problem with (2.1) and (2.2) is appropri-
ate to demonstrate the convergence of the FEM
for all possible orders p = 1, . . . , 5 of Lagrange
elements in COMSOL, since the right-hand side
f ∈ L2(Ω), which guarantees that u ∈ H2(Ω).
A larger study that extends convergence studies
of this type to non-smooth problems to demon-
strate the mathematical assumptions of (1.4) was
reported in [3].

By selecting a test problem which has a known
PDE solution u, a direct computation of the er-
ror u − uh and its norm in (1.4) can be achieved.
The convergence order q is then estimated from
these computational results by the following steps:
Starting from some initial mesh, we refine it uni-
formly repeatedly, which subdivides every triangle
into four triangles. If h measures the maximum
side length of all triangles, this procedure halves
the value of h in each refinement. Let r denote the
number of refinement levels from the initial mesh
and Er := ‖u− uh‖L2(Ω)

the error norm on that
level. Then assuming that Er = C hq, the error
for the next coarser mesh with mesh spacing 2h
is Er−1 = C (2h)q = 2q C hq. Their ratio is then
Rr = Er−1/Er = 2q and Qr = log2(Rr) provides
us with a computable estimate for q in (1.4) as
h → 0. Notice that the technique described here
uses the known PDE solution u; this is in contrast
to the technique described in [2] that worked for
Lagrange elements with p = 1 without knowing
the PDE solution u.

In Table 1 we list for each refinement level r,
the number of elements Ne in the mesh, the de-
grees of freedom (DOF), the FEM error Er =
‖u− uh‖L2(Ω)

, the ratio of error for consecutive
refinements Rr = 2q, and the estimate Qr =
log2(Rr) for the convergence order computed as
described in the Introduction. As expected, the
computed error tends to zero as the number of
refinements increases. In addition for a given re-
finement level, the error is smaller for higher or-
der Lagrange elements. We observe that through
p = 1, . . . , 5 the convergence order estimate Qr is
consistent with the predicted value q = p + 1.

3 Use of COMSOL 4.0

In this section, we demonstrate how to conduct the
convergence studies from the previous section us-
ing the GUI of COMSOL 4.0. For convenience, the
instructions for this process are divided into three
subsections. In Subsection 3.1, the test problem
will be solved up to the point of the default plot
created after solving it. Subsection 3.2 outlines the
post-processing of the solution including changing
the appearance of the solution plot and computing
the FEM error by domain integration. Lastly in
Subsection 3.3, we describe how to solve the same
problem repeatedly on progressively finer meshes
to obtain the convergence study and how to mod-
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(a)

(b)

Figure 1: Elliptic test problem on polygonal do-
main: (a) extremely coarse mesh, (b) FEM solu-
tion.

ify the solution process to obtain the convergence
studies for other degrees of the Lagrange elements.
This section also motivates the idea of saving the
entire solution process to an mph-file at the appro-
priate moment, so as to have it available for solving
again.

Start the GUI of COMSOL by typing comsol at
the Linux prompt or double clicking the COMSOL
Multiphysics icon on a Windows operating system.

3.1 Solution in the GUI

This section gives step-by-step instructions how to
solve the elliptic test problem from Section 2 in
COMSOL’s GUI.

1. Once the GUI loads, under the Model Wiz-
ard Window in the central window pane of
the GUI, choose 2D on the Select a Space Di-

mension page. In order to proceed, click the
Next button (right arrow) on the toolbar of
this page. The Add Physics page replaces the
Model Wizard in the center pane.

2. On the Add Physics page, expand the Mathe-
matics branch (by clicking on the down arrow
to the left of the label) and then the PDE
Interfaces branch, and select the Coefficient
Form PDE node. Click the Add Selected but-
ton (plus sign below window). By default, the
number of dependent variables is one and the
variable name is u. Since this is the desired
setup for the problem, click the Next button
(right arrow).

3. Under the Select Study page, select Stationary
and click the Finish button (checkered flag) on
the toolbar of this page.

4. Before proceeding to establish the specifics
of the test problem, check to ensure that all
needed information will easily be displayed. In
the Model Builder window in the left pane of
the GUI, click the View Menu (upside down
triangle) on the toolbar and make sure that
Show More Options is properly checked; this
setting is saved from one COMSOL session to
the next, so once this is selected, COMSOL
will retain this selection for future restarts.

5. In order to set up the desired domain, right
click Geometry 1 and select Square in the
Model Builder window. By default, this
will generate the desired square domain Ω =
(0, 1)× (0, 1) with one corner of the square at
the origin.

6. In the Model Builder window in the left win-
dow pane, the right-hand side of the PDE can
be set by expanding the PDE branch and se-
lecting the Coefficient Form PDE 1 node.
The center pane of the GUI specifies the gen-
eral form of the equation currently selected as

ea
∂2u

∂t2
+da

∂u

∂t
+∇·(−c∇u−αu+γ)+β·∇u+au = f.

Under Source Term, enter for f the expression
(-2*piˆ2)*(cos(2*pi*x)*sin(pi*y)ˆ2
+sin(pi*x)ˆ2*cos(2*pi*y)). Also, set the
Coefficient da to zero to recover a Stationary
problem. Leave the other coefficients as their
default values in order to establish the Poisson
equation of 1.1
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7. The desired boundary conditions of the test
problem can be generated by right clicking
the PDE branch in the Model Builder win-
dow in the left pane and selecting Dirichlet
Boundary Conditions. Select the Dirichlet
Boundary Condition 1 branch in the Model
Builder window, then in the Dirichlet Bound-
ary Condition page in the center pane under
Boundaries, choose All boundaries under Se-
lection.

8. Again in the Model Builder window in the
left pane, select the PDE branch and on the
PDE page in the center pane under Discretiza-
tion (you might have to expand Discretization
first), choose 1 for the Element order. This es-
tablishes the degree of the Lagrange elements
used. By selecting the element order to be 1,
COMSOL will use linear Lagrange elements in
the finite element solution.

9. In order to generate the FEM mesh that will
be used to compute the FEM solution, first
right click the Mesh 1 branch under the
Model Builder window and select Free Trian-
gular to establish the mesh. On the Free Tri-
angular page in the center pane, under the Do-
mains item, select for Geometric entity level
the selection Domain. Under the Mesh 1
branch, select the Size node and on the Size
page under Element Size, choose Extremely
coarse for the Predefined Elements Size. In
order to see the mesh being used, right click
the Mesh 1 branch and choose Build All. Fig-
ure 1 (a) displays the extremely coarse mesh
that will be used to compute the FEM solu-
tion. The number of triangular elements used
in this mesh can be determined by right click-
ing the Mesh 1 branch and choosing Statis-
tics. For this domain and extremely coarse
mesh, the number of triangular elements are
26.

10. Now, compute the FEM solution by right
clicking the Study 1 branch under the Model
Builder window and selecting Compute. Al-
ternatively, one can click the green equal sym-
bol above the Study page on the toolbar. Once
the solution is computed, the degrees of free-
dom which have been solved for can be seen
below the Graphics window in the Messages
tab, which is 20 for this coarse mesh using lin-
ear Lagrange (element order 1) elements.

(a)

(b)

Figure 2: Post-processing of FEM solution:
(a) three-dimensional view of solution , (b) three-
dimensional view of error.

3.2 Post-Processing

Solving the problem in the GUI leads to the so-
lution in a default plot shown in Figure 1 (b). A
more conventional way might be to present the so-
lution in a three-dimensional view. This subsec-
tion gives instructions on how to post-process the
FEM solution obtained in the previous subsection
by changing the plot to a three-dimensional view
and by computing the FEM error.

1. Under the Results branch of the Model
Builder window, expand the 2D Plot Group
1 branch, right click on the Surface 1 node
and choose the Height Expression. This shows
a three-dimensional surface and height plot
of the FEM solution uh(x, y). The result is
shown in Figure 2 (a). The previous subsec-
tion specifically used linear (p = 1) Lagrange
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elements to solve the problem, which means
that the FEM solution uh(x, y) is a flat patch
on each triangle of the mesh. This is clearly
visible in Figure 2 (a).

2. In order to construct a plot of the FEM er-
ror u − uh, right click the Results branch
and choose 2D Plot Group. This creates a
second plot group called 2D Plot Group
2. Right Click the 2D Plot Group 2
and select Surface. This creates the node
Surface 1 under the 2D Plot Group 2
branch. Select this Surface 1 node and on
the Surface page under expression, type the
formula for the error which is the difference
between the PDE solution and the FEM so-
lution: sin(pi*x)ˆ2*sin(pi*y)ˆ2-u. Then
right click this Surface 1 node and select the
Height Expression. Figure 2 (b) shows a three-
dimensional surface and height plot of the er-
ror.

3. The convergence studies of the FEM solution
rely on the L2(Ω)-norm Er = ‖u− uh‖L2(Ω)

of the FEM error with the norm defined
in (1.3) with v = u − uh. COMSOL can
compute the integral

∫
(u − uh)2 dx that ap-

pears in this norm definition; this integral
is then the square E2

r of the desired error
norm Er. To compute this integral, right
click the Derived Values branch on the
Model Builder and select Surface Integration.
Choose all domains under Selection on the
Surface Integration Page. Below expression,
type the square (u − uh)2 of the error as
(sin(pi*x)ˆ2*sin(pi*y)ˆ2-u)ˆ2. Click to
check mark the Description and label this
quantity by typing E rˆ2 to indicate that it
is the square of the norm of the error. Now,
right click the Surface Integration node on
the Model Builder window and select Evaluate
and New Table. The result of the computation
is 0.0116 and shown in the Results tab under
the graphics area.

4. It is useful to save the solution process as
a COMSOL mph-file at this stage before
mesh refinements to have it available as start-
ing point later when considering higher or-
der Lagrange elements. Under the File menu,
choose Save As .... This will automatically
save as an mph-file and append the extension
mph to the chosen filename.

3.3 Convergence Studies

In this subsection, we make use of the steps dis-
cussed in Subsection 3.2 in order to carry out a
convergence study. We repeatedly refine the mesh
that was used to compute the FEM solution, re-
compute the solution and its error norm, and then
copy all calculated error norms.

1. Refine the mesh by right clicking the Mesh 1
branch and under More Operations select Re-
fine. Under refinement, type 1 and rebuild the
mesh by right clicking the Mesh 1 branch and
selecting Rebuild All. Again, check the statis-
tics by right clicking the Mesh 1 branch and
selecting Statistics. With one refinement,
the number of triangular nodes has increased
by a factor of 4 to a total of 104 elements.
Recompute the FEM solution under this re-
finement by right clicking the Study 1 branch
and selecting Compute. Once the solution is
computed, right click the Surface Integra-
tion node and select Evaluate and choose Ta-
ble 1 to add the result to the previous created
table. Continue this process through several
refinements. The Results tab under the graph-
ics window accumulates all results for E2

r over
the course of these refinements.

2. After following the above procedure through 4
consecutive refinements, we can copy the data
for the squares E2

r of the FEM errors from the
table under the Results tab into some other
software, such as MATLAB, for further pro-
cessing. This is how the E2

r column in Table 1
was obtained. The remaining columns in this
table can be readily computed using the quan-
tites Rr and Qr defined in Section 1.

Following the previous steps in this section pro-
vides a convergence study for the Lagrange ele-
ments of order p = 1. In order to perform conver-
gence studies for higher order Lagrange elements,
start from the mph-file from the end of Section 3.2
that was saved before any mesh refinements. From
the File menu, choose Open to load the file. Once
the file is loaded, expand the Model 1 branch,
then select the PDE branch, and change the order
of the Lagrange element being used under the Dis-
cretization to a different order. By retracing the
mesh refinement steps of this section, the values
shown in Table 1 can be obtained for all degrees
p = 1, . . . , 5.
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Table 1: Convergence study for the elliptic test
problem using Lagrange elements.

(a) Lagrange elements with p = 1

r Ne DOF E2
r Er Rr Qr

0 26 20 1.160e–02 1.077e–01 NA NA
1 104 65 7.033e–04 2.652e–02 4.06 2.02
2 416 233 4.501e–05 6.709e–03 3.95 1.98
3 1664 881 2.836e–06 1.684e–03 3.98 1.99
4 6656 3425 1.775e–07 4.214e–04 3.99 1.99

(b) Lagrange elements with p = 2

r Ne DOF E2
r Er Rr Qr

0 26 65 4.351e–05 6.596e–03 NA NA
1 104 233 1.259e–06 1.122e–03 5.88 2.56
2 416 881 2.076e–08 1.441e–04 7.79 2.96
3 1664 3425 3.294e–10 1.815e–05 7.94 2.99
4 6656 13505 5.180e–12 2.276e–06 7.97 3.00

(c) Lagrange elements with p = 3

r Ne DOF E2
r Er Rr Qr

0 26 136 6.991e–06 2.644e–03 NA NA
1 104 505 2.031e–08 1.425e–04 18.56 4.21
2 416 1945 7.460e–11 8.637e–06 16.50 4.04
3 1664 7633 2.834e–13 5.327e–07 16.22 4.02
4 6656 30241 1.095e–15 3.309e–08 16.10 4.01

(d) Lagrange elements with p = 4

r Ne DOF E2
r Er Rr Qr

0 26 233 6.634e–09 8.145e–05 NA NA
1 104 881 1.467e–11 3.830e–06 21.27 4.41
2 416 3425 1.578e–14 1.256e–07 30.49 4.93
3 1664 13505 1.605e–17 4.006e–09 31.36 4.97
4 6656 53633 1.595e–20 1.263e–10 31.71 4.99

(e) Lagrange elements with p = 5

r Ne DOF E2
r Er Rr Qr

0 26 356 7.656e–10 2.767e–05 NA NA
1 104 1361 1.421e–13 3.770e–07 73.39 6.20
2 416 5321 3.421e–17 5.849e–09 64.45 6.01
3 1664 21041 8.306e–21 9.114e–11 64.174 6.00
4 6656 83681 1.819e–24 1.349e–12 67.58 6.08
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